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This Tutorial 

Tutorial Objective 
This tutorial interactively introduces a number of high-level concepts to ensure that you 
understand how GeoMedia 3D is designed to work.  The intent of this tutorial is not to review all 
aspects of the product, but to quickly introduce you to the basic functions within GeoMedia 3D. 

 

Tutorial Data Set 
The exercises outlined in the GeoMedia 3D tutorials make use of specific data sets.  Specifically, 
the GeoMedia 3D tutorial data sets include:  vector sources (point, line, and area features), raster 
sources (aerial photographs in GeoTIFF format), and elevation sources in ERDAS Imagine and 
USGS SDTS formats. 

 

Tutorial Text Conventions 
There are several conventions used throughout the tutorial: 

 Ribbon bar items are shown as: On the Aaa tab, in the Bbb group, click Ccc. 

 Dialog box names, field names, and button names are depicted using Bolded Text. 

 Information to be entered, either by selecting from a list or by typing, is depicted using 
Italicized Text. 

 

Tutorial Prerequisites 
There are no prerequisites for making use of this tutorial; however, having a basic understanding 
of the GeoMedia Desktop will be helpful in expediting the execution of certain steps within this 
tutorial.   





 

   

Understanding the Tutorial Section 1:  
Data Set 

Section Objective 

This section is intended to introduce you to the dataset that has been supplied as part of the 
GeoMedia 3D tutorial resource set. Namely, in this section you will learn about: 

 
 GeoMedia GeoWorkspaces and how they are used to launch GeoMedia Desktop and 

hence GeoMedia 3D. 

 GeoMedia warehouses and how connections work within a GeoMedia GeoWorkspace. 

 Skyline® *.fly and Skyline *.mpt files and why they are integral to GeoMedia 3D. 

 GeoTIFF files and how they can be leveraged for display in GeoMedia 3D (specifically, 
how imagery can be draped over a terrain surface). 

 ERDAS IMAGINE files and USGS SDTS files and how they can be used to 
update/replace default terrain information within GeoMedia 3D. 

 KMZ, DAE, CityGML, and XPL files and how they can be used to enhance a view within 
GeoMedia 3D; specifically, how these file types can be used to add 3D objects to the 3D 
map window. 

 

Tools Used 

Desktop tools are used to explore the folders and sub-folders containing the Tutorial dataset for 
GeoMedia 3D. 
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 Exploring the Tutorial Data Exercise 1:

Objective: 
The objective of this exercise is to introduce you to the GeoMedia 3D tutorial data set. 

Task 1: Locating the Tutorial Data 

All of the data for the GeoMedia 3D tutorials is located in a single folder. 

1. Use your mouse and desktop controls to navigate to C:\GeoMedia 3D Tutorial. 

 

This folder contains all of the data needed to work your way through 
the tutorials. All of the data has been logically categorized into folders 
so that you can easily see the different file types that can be 
integrated into GeoMedia 3D workflows. 

Task 2: Locating the GeoWorkspaces 

GeoWorkspace (*.gws) files are created in GeoMedia Desktop.  These files are saved to disk with 
objects specific to GeoMedia and include components such as connections to warehouses and 
legend stylization parameters. GeoWorkspaces are typically used to start GeoMedia Desktop and 
hence GeoMedia 3D. 

1. Use your mouse and desktop controls to navigate to C:\GeoMedia 3D 
Tutorial\Warehouses. 

 

This folder contains all of the Warehouses needed to work your way 
through the tutorials. You will be making use of these warehouses to 
learn how to make use of GeoMedia 3D. Specifically, you will use the 
contents of these files to learn how to set the 3D display styles of 
image, text, area, linear, and point-based feature classes. 

Task 3: Understanding and Locating Content Files 

The GeoMedia 3D tutorial data set delivers two *.fly files and one *.mpt file. These files are used 
as base content files. 

1. Use your mouse and desktop controls to navigate to C:\GeoMedia 3D Tutorial\Fly & 
MPT Files. 

 

This folder contains a small collection of *.fly and *.mpt files. These 
files are referred to as base content files in GeoMedia 3D.  They use 
a globe representation to display spatial information. 
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Content files are the foundation upon which you can add your GIS data. The GeoMedia 3D 
tutorial resources include two such content files (Default_Internet.fly and Default_Local.fly). The 
Default_Internet.fly file links to a TerraGate® server and therefore a local MPT file is not required. 
With this content file, the imagery and terrain is served to the 3D map window via the Internet. 
You will notice in subsequent tutorials how the imagery and terrain is displayed when using this 
content file. 

 

If you intend to display large amounts of imagery or terrain data, you 
may want to consider implementing your own TerraGate server, as 
this technology has been specifically designed to stream large 
amounts of these types of data to the GeoMedia 3D map window. 

The Default_Local.fly file links to a local MPT file called Default_Local_Terrain.mpt and therefore 
the Internet is not required to use this content file. The two content files appear to yield similar 
content, but upon closer inspection, you will notice that these files are quite different.  In the 
example graphic below, the differences between the two files are enumerated. 

 

These differences are not easily seen when viewing the data using smaller map scales. In the 
example below, the west coast of North America is depicted at a map scale of approximately 1:25 
million and the location of San Francisco, California, USA is highlighted using a yellow rectangle. 
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These two representations again, given the smaller map scale, appear to yield similar results, but 
as you zoom in on these data sets, you will begin to see the difference in the content. 

In the example below, a portion of San Francisco is presented at a map scale of approximately 
1:100,000 and the yellow rectangle is used represent the same geographic area in each map. 

 

As can be seen in the examples above, the Default_Internet.fly file depicts content within San 
Francisco, while the Default_Local.fly file does not.  As the user continues to zoom in on an area 
within the Default_Internet.fly file, more detail will be displayed, while no additional detail will be 
displayed in the Default_Local.fly. 

In the example below, a football field within San Francisco is depicted at a map scale of 
approximately 1:2,000. 

 

Notice that the map on the left is presented in a high oblique (top-down) view and it clearly 
displays the football field and characteristics within it (such as yard line markers). The map on the 
right is depicting the same location as the map on the left, but is using a low oblique (side) view.  

When looking at data within the Default_Internet.fly file with a low oblique view, the terrain within 
this file is also noticeable. As noted above, the Default_Internet.fly file contains elevation for the 
entire globe at a mixture of resolutions. 

 

 

The Default_Local.fly file also contains a pointer to an *.MPT file that 
contains elevation for the entire globe, albeit at an extremely coarse 
resolution. 

The *.MPT format is the published surface file format.  These files can contain elevation/surface 
models and/or imagery.  The *.FLY format is a container file that can be linked to *.MPTs as well 
as other 3D objects, vector formats, images, and so forth. 
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If you have your own collection of FLY/MPT files, you can make use 
of these instead of using the default files. However, there are pros 
and cons associated with working with pre-built Skyline files.  

In short, you can augment your FLY/MPT files with all kinds of data 
using GeoMedia 3D and in doing so maintain connectivity to the 
database (that is, you can dynamically ask questions of these data 
and map the answers thematically, just like you would using a 2D 
map window); however, display performance can be affected as the 
number of features added via GeoMedia 3D increases.  

Given this, you might want to consider using Skyline to pre-load 
some features (that is, add features that are static to a FLY/MPT file 
using Skyline).  For example, if you have a large collection of 
orthophotographs, high-resolution sets of terrain files, or 3D models, 
these features could be pre-loaded into a FLY/MPT file and therefore 
optimized for display, potentially making the process of toggling to 3D 
faster. 

Additionally, if you are currently making use of a TerraGate server, you can use GeoMedia 3D to 
reference a FLY file that is connected to TerraGate and in turn have TerraGate stream features 
into the 3D window. 
 

 

TerraGate suite is a family of tools designed to support the client-
server data delivery requirements of the Skyline 3D technology. With 
the TerraGate tools, you can stream terrain databases and features 
stored on a server remote to GeoMedia 3D users. 

Task 4: Understanding and Locating TIFF Files 

A TIFF (Tagged Image File Format) file is a raster image file with the extension .tif.  GeoTIFF is a 
specification for embedding geographic information, such as projections, datums, and so forth, 
associated with remote sensing or cartographic raster data, in TIFF files as tags. The geographic 
data can then be used to correctly position the image within GeoMedia Desktop. 

1. Use your mouse and Windows desktop controls to navigate to C:\GeoMedia 3D 
Tutorial\Imagery\Landsat Imagery (Low Resolution). 

 

This folder contains a Landsat image of the island of Oahu in Hawaii. 
This image was made from a Landsat Enhanced Thematic Mapper 
and is dated 14 September 2001. For more information on Landsat, 
see http://landsat.usgs.gov/. 

 

http://landsat.usgs.gov/
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Landsat image of the island of Oaho 

This image covers the entire island of Oahu and will be draped over the terrain files noted below. 
However, higher resolution orthophotographs will also be used, and these will be draped over 
specific areas in Honolulu. 

2. Use your mouse and Windows desktop controls to navigate to C:\GeoMedia 3D 
Tutorial\Imagery\Ortho Photographs (High Resolution). 

 

This folder contains a small collection (4 GeoTIFF files) of high-
resolution aerial photographs of the Honolulu area in Hawaii. 

 

Four GeoTIFF files placed on top of the Landsat image 

These data will be used to illustrate how the Default_Local.fly file that is delivered with GeoMedia 
3D can be augmented with higher-resolution imagery and terrain. 
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Default_Local.fly file with Parks, Wetlands, and Rivers displayed 

 

 

Default_Local.fly file with High Resolution GeoTIFF imagery draped over 10-meter terrain 

Task 5: Understanding and Locating Elevation Files 

Elevation files contain surface information and are typically referred to as Digital Elevation Models 
(DEMs). The GeoMedia 3D tutorial includes two such file types (32-bit data GeoTIFF and ERDAS 
IMAGINE) files. 

1. Use your mouse and Windows desktop controls to navigate to C:\GeoMedia 3D 
Tutorial\Elevation Files. 

SDTS, or Spatial Data Transfer Standard, is a specification designed to facilitate the transfer of 
digital spatial data between different computer systems with diverse hardware and software. A 
DEM in this format consists of a set of files that include both spatial data and metadata such as a 
data dictionary and quality report. All of these files have the .ddf extension. These files all have 
projection information and contain a matrix of values to represent elevation.  However, these data 
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sets typically contain a border of VOID values and the VOID values should be removed before 
using the data within GeoMedia 3D. 

Given this, an SDTS file of Honolulu was imported into GeoMedia Grid and the VOID values were 
removed using a set of interpolation commands. Once the VOID values had been removed, the 
resulting DEM was exported to a 32-bit data GeoTIFF. 

32-bit data GeoTIFF files are used to store and exchange DEM information. These files can be 
imported into a wide variety of products (including GeoMedia 3D) and in turn used to represent 
the elevation of the surface for specific areas. 

2. Use your mouse and Windows desktop controls to navigate to C:\GeoMedia 3D 
Tutorial\Elevation Files\SDTS Elevation. 

 

This folder contains one folder containing one 32-bit GeoTIFF file 
(Honolulu SDTS.tif). These data will be used to illustrate how the 
Default_Local.fly file that is delivered with GeoMedia 3D can be 
augmented with higher resolution terrain. 

 

            

  Default_Local.fly file with high-resolution imagery           Default_Local.fly file with high-resolution imagery and SDTS terrain 

The changes in the above example are subtle, but if you look closely, you can see that the rim of 
Diamond Head (a volcanic tuff cone) is elevated. 

ERDAS IMAGINE is an image processing system that can be used to create DEM files, and 
these files can be used to augment your surface in GeoMedia 3D. 

3. Use your mouse and Windows desktop controls to navigate to C:\GeoMedia 3D 
Tutorial\Elevation Files\IMG Elevation. 

 

This folder contains one ERDAS image file. These data will be used 
in tandem with the USGS SDTS file noted above to illustrate how the 
Default_Local.fly file that is delivered with GeoMedia 3D can be used 
in tandem with the SDTS DEM noted above. 
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Task 6: Understanding and Locating 3D Model Files 

GeoMedia 3D supports the import, placement, and display of SKP, KMZ, COLLADA (DAE), 
CityGML, DirectX®, and XPL objects. These file formats can be used to add a wide variety of 3D 
objects to your 3D views. You can add 3D objects via styles/properties dialog boxes in GeoMedia 
3D, or you can import 3D objects via a utility specifically designed to convert a collection of 3D 
objects into a format that is optimized for GeoMedia 3D.  Methods for working with 3D objects are 
discussed in other tutorials. 

SketchUp (*.skp) files are native to Trimble® SketchUp®. Trimble SketchUp is a 3D modeling 
program designed for architects, civil engineers, filmmakers, game developers, and related 
professions. With Trimble SketchUp, users would typically save their models to the SKP format 
that is native to Trimble SketchUp. 

Keyhole Markup Language (KML) is an XML-based language schema for expressing geographic 
annotation and visualization on existing or Internet-based, two-dimensional maps and three-
dimensional Earth browsers. The KML file specifies a set of features (place marks, images, 
polygons, 3D models, textual descriptions, and so forth) for display in 3D applications such as 
GeoMedia 3D.  Each place always has a longitude and latitude. 

KML files are very often distributed in KMZ files, which are zipped files with a .kmz extension. The 
contents of a KMZ file are a single root KML document (such as doc.kml) and optionally any 
overlays, images, icons, and COLLADA 3D models referenced in the KML including network-
linked KML files. The root KML document is typically a file named doc.kml at the root directory 
level but the first .kml file entry in the KMZ file is the actual one selected in Google Earth™ 
regardless of its name. By convention, the root KML document is at root level and referenced files 
are in subdirectories (such as images for overlay images). 

COLLADA™ is a COLLAborative Design Activity for establishing an interchange file format for 
interactive 3D applications. COLLADA is managed by the not-for-profit technology consortium, 
the Khronos™ Group. 

COLLADA defines an open standard XML schema for exchanging digital assets among various 
graphics software applications that might otherwise store their assets in incompatible file formats. 
COLLADA documents that describe digital assets are XML files, usually identified with a .dae 
(digital asset exchange) file name extension. 

CityGML is a common information model for the representation of 3D urban objects. It defines the 
classes and relations for the most relevant topographic objects in cities and regional models with 
respect to their geometrical, topological, semantical, and appearance properties. 

CityGML is realized as an open data model and XML-based format for the storage and exchange 
of virtual 3D city models. It is implemented as an application schema for the Geography Markup 
Language 3 (GML3), the extendable international standard for spatial data exchange issued by 
the Open Geospatial Consortium (OGC®) and the ISO TC211. CityGML is intended to become 
an open standard and therefore can be used free of charge. 

XPL files are specific to Skyline (that is, they are the internal rendering format) and therefore are 
optimized for display performance. 3D objects are typically distributed as DAE and DirectX 
format; however, if you intend to use large quantities of these file types (that is, attach detailed 
models to point features and display them), it is suggested that you convert your DAE or X files to 
XPL format first. A discussion on how to do this is outlined later in the Working with Point 
Features tutorial.Elevation files contain surface information and are typically referred to as Digital 
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Elevation Models (DEMs). The GeoMedia 3D tutorial includes two such file types (32-bit data 
GeoTIFF and ERDAS IMAGINE) files. 

1. Use your mouse and Windows desktop controls to navigate to C:\GeoMedia 3D 
Tutorial\3D Symbols. 

 

This folder contains a small collection of 3D symbols in a number of 
formats. These will be used to illustrate how your 3D view can be 
updated with these models. 

 

  

    Traffic light model in DAE format                  Traffic light model placed in context in a 3D window (including palm trees and a park bench) 

An important concept to understand is that Z values, attribution, or user-defined values can be 
used to suspend point symbols above the surface, or even to attach a device on the side of 
another symbol or 3D object. 

   

   3D model of a PTZ camera   PTZ camera suspended above surface near the traffic light pole (appears to be attached) 

GeoMedia 3D also includes an import utility that allows you to import 3D models that are 
geospatially referenced. In these cases, the models are automatically placed geographically in 
their correct locations.  

Please note that 3D models, once imported using the Import 3D Models utility, can be converted 
to a 3D Mesh Layer (3DML) for improved performance using the Construct 3D Mesh Layer 
command. 3DML surfaces are specialized representation of the landscape that are highly 
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optimized for rendering inside of GeoMedia 3D. Given this, users with extremely large collections 
of building models should consider converting their datasets to this format. 

 

Buildings models (those with textures) imported via the Import 3D Objects utility 

Texture files can be used to paint the sides and or tops of extruded features. If you only have 
building footprints, you may want to consider this option to provide realism to your buildings. 

 

Example of using texture files to texture the sides and tops of three buildings 

2. Use your mouse and Windows desktop controls to navigate to C:\GeoMedia 3D 
Tutorial\Textures. 

 

You will notice that there are three folders; these folders contain the 
textures files needed to complete exercises 3B and 3C. 
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Ensuring that GeoMedia 3D Section 2:  
is Working 

Section Objective 

The intent of this section is to quickly ensure that GeoMedia 3D is functioning as designed (that 
is, to establish that the product is installed correctly). To accomplish this, you will walk through a 
number of high-level functions and gain some insight into how GeoMedia 3D is designed and 
what some of its key capabilities are. 

Later tutorials will be used to present specific workflows and to outline how to achieve good 
results with a wide variety of data sets. 

You must be connected to the Internet to complete this exercise, as one of the base content files 
used makes use of a TerraGate® connection to serve imagery and terrain information to the 3D 
map window. In this section, you will learn how to: 

 
 Start GeoMedia Desktop and hence start GeoMedia 3D. 

 Specify a base content file. 

 Toggle an existing 2D map window to the 3D map window. 

 Use GeoMedia navigation controls to interactively navigate the GIS data within the 3D 
map window. 

 Use GeoMedia 3D navigation controls to interactively navigate the GIS data within the 3D 
map window. 

 Use the GeoMedia Select tool to display the Properties dialog box and review attributes. 

 Use the Legend Entry Properties dialog box to update the display aspects of a legend 
entry. 

 Toggle a 3D map window into a 2D map window. 

 Create a new 3D map window. 

 Exit GeoMedia Desktop. 
 

Tools Used 

A variety of GeoMedia 3D commands are used to gain a basic understanding of GeoMedia 3D. 
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 Launching GeoMedia 3D and Exercise 1:
Creating a 3D Window  

Objective: 
The objective of this exercise is to learn how to launch GeoMedia 3D and in turn create a 3D 
representation of your GIS data. 

Task 1: Launching GeoMedia Using a GeoWorkspace 

GeoMedia Desktop and hence GeoMedia 3D can be started just like any other Windows 
application. In this particular case, GeoMedia Desktop will be started using the GeoWorkspace 
that has been provided as part of this tutorial. 

1. Use your mouse and Windows desktop controls to navigate to C:\GeoMedia 3D 
Tutorial\GeoWorkspaces. 

2. Double click on Exercise 1b.gws. This action starts GeoMedia Desktop and opens 
the GeoWorkspace called Exercise 1b. 

 

Task 2: Toggling a 2D Map Window to the 3D Map Window 

GeoMedia 3D allows you to toggle a 2D map window like the one shown above to the 3D map 
window or alternatively create a new 3D map window. Please note that only one 3D map window 
can be open at one time.  

In this particular instance, MapWindow1 has never been toggled to a 3D window, and therefore a 
base content file has not yet been assigned to this window. Since MapWindow1 has never been 
toggled to 3D, you are going to make use of the 3D Options command to ensure that the correct 
content file is assigned to this map window 

1. On the 3D tab, in the Preferences group, click GeoMedia 3D to display the 3D 
Options dialog box. 
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The 3D Options dialog box is used to set a large number of 
preferences for GeoMedia 3D and hence a tabbed dialog approach is 
used to logically divide the settings. 

2. Click on the General tab to make it the active tab. 

3. Ensure the Base content file is set to C:\GeoMedia 3D Tutorial\Fly & MPT 
Files\Default_Internet.fly.  If it is not, use the Browse button to update this reference. 

 

As noted above, FLY/MPT files are used as the foundation upon 
which all features are placed. If you have your own FLY/MPT files, you 
can point GeoMedia 3D to these files and GeoMedia 3D will use them 
as the foundation for 3D visualization. 

In this case, the Default_Internet.fly file links to a TerraGate server 
and therefore a local MPT file is not required. With this content file, the 
imagery and terrain is served to the 3D map window via the Internet. 

4. Click Apply if you made a change to accept any option changes.  

5. Click Close to close the 3D Options dialog box. 

6. On the 3D tab, in the View group, click Toggle 3D to convert MapWindow1 into a 3D 
map window.  

Your 2D map window will toggle to the 3D map window using the specified base content file. With 
this base content file, you should notice that imagery has been added to the map window. This 
imagery is being streamed via the Internet using a TerraGate server. 

 

Legends are shared by the 2D/3D windows and therefore each feature class that is currently 
displayed in the legend is converted to a 3D representation using a combination of 2D and 3D 
style settings. 

It is important to understand that the GeoMedia 3D map window attempts to adhere to display 
properties whenever possible.  In this case, some of the legend entries have had the Display by 
Scale property applied to them; these legend entries will therefore toggle on and off depending on 
the display scale set when roaming within the 3D map window.  The 3D properties and stylization 
used here will be covered in detail later in this document to show how properties and stylization 
can be used to achieve the results that are in the 3D map window. 
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 Exploring the Contents of a 3D Exercise 2:
Map Window 

Objective: 
The objective of this exercise is to learn how to make use of both GeoMedia Desktop commands 
and GeoMedia 3D commands to explore the contents of the 3D window. 

Task 1: Navigate the 3D window using GeoMedia Commands 

GeoMedia 3D allows you to explore your GIS data in the 3D map window using the standard 
navigation controls supplied as part of GeoMedia Desktop. 

1. On the Home tab, in the Extent group, click the Zoom In button to activate the 
Zoom In button (small magnifying glass with a + symbol).  
Your cursor will change into a small magnifying glass with a + symbol. 

2. Move your cursor over the center of the map and click once. Notice that your 3D view 
zoomed in one level. 

3. Move your cursor over the map and click and drag to define a rectangle. Once you 
have defined a rectangle, release the mouse button. Notice that as soon as you 
release the mouse button, the 3D view updates to reflect the extents of your 
rectangle. 

4. On the Home tab, in the Extent group, click the Zoom Out button to activate the 
Zoom Out button (small magnifying glass with a – symbol).  
Your cursor will change into a small magnifying glass with a – symbol. 

5. Move your mouse over the map and click once. Notice that your 3D view zoomed out 
one level. 

6. Right click on the legend entry Structure_Footprint to highlight it and to display the 
right-click menu, then select the Fit by Legend Entry command. Your 3D map 
window should look similar to the sample below. 

 

7. A nominal map scale of 1:500 has been set for this GeoWorkspace. On the Home 
tab, in the Extent group, click Zoom to Nominal Map Scale to set your map view to 
1:500. Your 3D map window should look similar to the sample provided below. 
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With the exception of the Pan tool, the GeoMedia navigation tools 
typically work best when you are in a top-down view. Once you start 
tilting your view, it is best to make use of the 3D navigation tools that 
are located in the upper right portion of the 3D map window. 

When in the 3D map window, the GeoMedia Pan tool acts more like 
a grab tool.  You will learn more about how to use this tool later in 
this tutorial. 

 

Task 2: Navigate the 3D window using GeoMedia 3D Commands 

Since you have an active 3D map window, you will notice an extra set of navigation controls in 
the upper right corner of the 3D map window. These controls provide additional navigation 
capabilities to those noted above. With these navigation controls, in addition to zooming and 
panning, you can also rotate and tilt the contents of your 3D map window. 

1. Move your cursor over the navigation tools in the upper right corner of the 3D map 
window. Notice that once the cursor is over these controls, the controls update and 
present more functionality. Namely, the system displays controls for tilt (the tilt 
slider), rotate (the compass ring), pan (the joystick and arrows), and zoom. 

 

2. Move your cursor over the tilt slider and click on the blue triangle and drag it to a 
new position. 
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Notice that the contents of your 3D map window change to reflect the specified view angle. 

 

You should see two types of buildings: some gray buildings and some buildings with textures. 
The buildings have been stored in separate feature classes and have different 3D styles applied 
to them. We will discuss how you can create these results using styles in later tutorials. 

The sample buildings that include textures were created using FME® Workbench from Safe 
Software using the Structure_Footprint feature class and a small collection of aerial 
orthophotographs as input. This process was used to demonstrate how realistic-looking buildings 
could be created in an automated fashion using only building footprints, some textures, and aerial 
photographs as input. 

During the DirectX/xpl2 creation process, the footprints were extruded upwards by the building 
height and a roof cap was added to create 3D models of the buildings. Roof textures were clipped 
from the orthophotographs, while wall textures were randomly assigned from a library based on 
building classification. 

You do not need FME to create this type of representation; however, the FME process is 
automated and does provide a quick methodology for creating extruded buildings for a large 
number of features. In subsequent tutorials, you will learn how attribution can be used to apply 
textures to buildings and obtain similar results. 

3. Double click the N in the compass ring to return the rotation of the 3D map window 
back to the North position. 

4. Move your cursor over the joystick and click on the blue circle and drag it to the left. 

 

Notice that as you drag, the contents of the 3D map window moves to reflect the location of the 
blue circle. Continue to pan until you see more and more textured buildings, like those shown in 
the sample 3D map window below. 



22  Ensuring that GeoMedia 3D is Working 

 
 

 

5. Move your cursor anywhere over the compass ring and click and drag so that the 
North Indicator is to the right. 

  

6. Notice that as you drag the compass ring, the contents of the 3D map window 
rotates to match your new position. 

 

7. On the Home tab, in the Extent group, click Pan to activate the Pan tool. Your cursor 
will change into a small open hand. 

 

As noted above, when this tool is selected in a 3D map window, the 
GeoMedia Pan tool can act like a grab/roam tool or a pan tool. For 
example, you can:  

Click and drag – this will allow you to pan in increments (similar to how 
the GeoMedia Pan tools work). 

Grab a point in space and then use your mouse to swipe the cursor in 
the direction you want to travel; this will allow you to roam.  The faster 
you swipe, the faster the system will roam. 
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If you want to stop the roaming process, simply click anywhere in the 3D map window. If you want 
to change direction while roaming, simply grab a point in space and then use your mouse to 
swipe the cursor in the new direction you want to travel. With time, once you understand how this 
tool works, this method of navigation will likely become your favorite method for navigating within 
the 3D map window. 

8. Experiment with the navigation tools until you are comfortable with navigating around 
the 3D environment. 

9. Once you have completed exploring the contents of the map, move your cursor over 
the tilt slider, and click on the blue triangle and drag it to the topmost position. 

 

10. On the Home tab, in the Extent group, click Fit All to fit all of the features in the 3D 
map window. Your 3D map window should look similar to the sample provided below. 

 

With the North indicator in its current position (that is to the right), you will notice that the contents 
of the map reflect this view (that is, North is pointing to the right). You can change a map view so 
that North is in the uppermost position by dragging the rotation control to the North position or 
simply by double clicking the N in the rotation control. 

11. Double click the N in the compass ring to return the rotation back to a North 
position or alternatively click North on the 3D tab, in the Navigation group. Your 3D 
map window should look similar to the sample provided below. 
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 Reviewing and Using Attributes  Exercise 3:

Objective: 
The objective of this exercise is to learn how to review attributes, update attributes, and hence 
update the features within the 3D map window. 

Task 1: Navigate the 3D window using GeoMedia Commands 

As noted earlier, GeoMedia 3D is an add-on product, and as such, the GeoMedia Desktop 
command set works similarly whether you are invoking the command while the 3D map window is 
active or while a 2D map window is active. 

1. Zoom in to an area similar to the one provided below to a map scale that is 
approximately 1:1,000. 

 

2. Move your cursor over the tilt slider and click on the blue triangle and drag it to a 
new position. In short, set up your view so that you can easily see one of the gray 
buildings. 

 

3. On the Home tab, in the Selection group, click the Select button to activate the 
Select tool.  

4. Move the cursor over one of the gray buildings and notice that the building highlights. 
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It is best practice to click at the bottom portion of the building when 
attempting to locate/select it. Please note that your selection color 
may be different.  

 

5. Once the building in question highlights, double click the building to display the 
Properties dialog box. 

The Properties dialog box looks and acts the same regardless of whether it is invoked from a 2D 
map window or the 3D map window. Furthermore, the actual extrusion of this feature class is 
driven by an attribute: the MAXHT_M attribute is used to extrude each building. Again, just like in 
GeoMedia Desktop, if you change the value of an attribute that is driving a display style, the 
display will automatically update when an attribute value is modified. 

6. Move your cursor over the Value field for MAXHT_M and click to select the text in 
this field. 

7. Use your keyboard to enter a new value (either slightly higher or slightly lower than 
the existing value). 

8. Click OK to accept the new value and to close the Properties dialog box.  

9. Notice that the display for the selected item updates to reflect the new value for 
MAXHT_M. 

 

10. Once you have completed the steps above, move your cursor over the tilt control 
and click on the blue triangle and drag it to the topmost position. 
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11. On the Home tab, in the Extent group, click Fit All to fit all of the features in the 3D 
map window. Your 3D map window should look similar to the sample provided below. 
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 Executing a Query and Stylizing Exercise 4:
the Results 

Objective: 
The objective of this exercise is to learn how to execute a query and then in turn stylize the 
results for display within the 3D map window. 

Task 1: Execute a Query and Display Results 

In general, an attribute query is a request for information that is based upon one or more filters. 
For example, you could perform an attribute query on a parcel fabric where the filter is an 
assessed value that is greater than or equal to a value such as $125,000. In this instance, we are 
going to ask the database to display all motor vehicle thefts that occurred on Friday, Saturday, or 
Sunday. 

1. On the Analysis tab, in the Attribute group, click Attribute Query to display the 
Attribute Query dialog box. 

2. Use the Select features in drop-down list to set this value to ThematicFeatures > 
RMS_Motor_Vehicle_Theft. 

 

3. Use the Filter button to display the Where clause tab. 

4. Use the controls within the Where clause tab to define the following filter:  
DOW1 = 'FR' OR DOW1 = 'SA' OR DOW1 = 'SU'; 

 

5. Click OK once your filter has been properly defined. 

6. Uncheck the Display query in data window option. 

7. Ensure the Display query in map window option is checked. 
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8. Set the Query name to MVT. Your query dialog should look similar to the one shown 
below. 

 

9. Click OK to execute your query. 

Task 2: Stylize the Results 

System integration is important to the design of GeoMedia 3D.  System integration, in this 
context, specifically means that the new 3D style properties components should be seamlessly 
integrated into all workflows. 

The new 3D styles should appear as a natural extension of the existing Properties dialog box 
and ideally mimic the paradigm as closely as possible.  With this in mind, changing the styles of 
any legend entry essentially follows the paradigm already present in GeoMedia Desktop; the only 
difference is that now that you have GeoMedia 3D installed, all style dialog boxes have been 
updated to include a 3D Settings tab. 

Properties and styles will be detailed in later tutorials; therefore, specifics about each of the 
options are not provided here. 

1. Double-click the Style  icon beside the legend entry called MVT to display the 
Select Style dialog box. 

2. Click the Properties button to display the Style Properties dialog box. 

3. Click the 3D Settings tab to bring this tab to the forefront. You will see a number of 
new options all relating to placement and stylization of features in the 3D map 
window. 

4. Click the Use relative altitude based on radio button and select Surface from the 
drop-down list. 

5. Enter a value of 2 into the Use offset of field. 

6. Ensure the units are set to m. 

 

The unit field is used to qualify the value in the Use offset of field. 

7. Ensure the Replace with 3D object check box is checked. 

8. Click the Browse button to display the 3D Object dialog box. 
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9. Use the controls within the 3D object dialog box to specify the file:  C:\GeoMedia 3D 
Tutorial\3D Symbols\3D Point Symbols\ColorfulSphere (XPL2)\ColorfulSphere.xpl2, 
and click Open. 

10. Once the file has been specified, your dialog box should look similar to the sample 
below. 

 

11. Click OK to close the Style Properties dialog box. 

12. Click OK to apply your style settings. 

13. Use the navigation tools to zoom in and locate some incident locations. (You should 
notice a small collection of spheres hovering above the surface at about 2 meters 
similar to those presented below.) 

   

 

 

Please note that in subsequent tutorials you will learn much more 
about the new 3D Settings tab and how best to make use of these 
features. 

14. Once you have completed the steps noted above, move your cursor over the tilt 
control and click on the blue triangle and drag it to the topmost position. 
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15. Double click the N in the rotation control to return the rotation back to a North 
position. 

16. On the Home tab, in the Extent group, click Fit All to fit all of the features in the 3D 
map window. Your 3D map window should look similar to the sample provided below. 

 



 

 
 

    33 

 Toggling Windows Exercise 5:

Objective: 
The objective of this exercise is to learn how to toggle between the two window types – namely 
2D map windows and 3D map windows. 

Task 1: Toggle a 3D Map Window to a 2D Map Window 

GeoMedia 3D allows you to toggle the 3D map window to a 2D map window at any point. You 
can even display one 3D map window and multiple 2D map windows at the same time. 

1. On the 3D tab, in the View group, click Toggle 3D. Your 3D map window will toggle 
back to a 2D map window. 

When navigating within the 3D map window, the rotation of the map window changes to reflect 
your viewing position and as a result, when you toggle from a 3D map window to a 2D map 
window, the map rotation value may not be 0 degrees. Given this instance, we want to reset this 
value.  Changing this display property is easy. 

2. Right click anywhere in the 2D map window to display the right-click menu. 

3. Select the Display Properties menu item to display the Display Properties dialog 
box. 

4. Set the Rotation angle field to a value of 0. 

5. Click Apply to apply the new settings to the 2D map window and then click Close to 
close the dialog box. 

 

Another way to set the rotation back to 0° is to check the Set map 
window rotation to 0° when converting from 3D to 2D check box 
in the General tab in the 3D Options dialog box before toggling to 
2D. 

6. Click Close to close the Display Properties dialog box. 

7. On the Home tab, in the Extent group, click Fit All to fit the entire contents of the 
GeoWorkspace into the available display space. 
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Task 2: Create a New/Separate 3D Map Window 

As noted above, there may be instances where you want a 2D map window and a 3D map 
window displayed side-by-side.  This can be done using the New 3D Map Window command 
while a 2D map window is open. 

1. On the 3D tab, in the View group, click New 3D to display the New 3D Map Window 
dialog box. 

 

The New 3D Map Window command acts similarly to the New Map 
Window command in GeoMedia Desktop. You can open a new map 
window with no features, or you can specify the type of legend you 
want to associate with the new map window. 

This command differs from the GeoMedia New Map Window 
command in that you do need to specify a Base content file (this 
drop-down list should default to the one you set earlier in this 
exercise), and you can set the window location using a check box. 

2. Do not change the default Window name, as this name will suffice for now. 

3. Ensure the Base content file is set to C:\GeoMedia 3D Tutorial\Fly & MPT 
Files\Default_Local.fly.  If it is not, use the Browse button to specify this file and then 
click Open. 

4. Click on the entry called TutorialLegend in the Select legend to display list. 

 

The Name Legend command within GeoMedia Desktop was used to 
create a default 3D legend for this exercise. 

5. Check the Use active window location check box so that when the new 3D map 
window is created, it will automatically zoom to the same location as the active map 
window. (Your dialog box should look similar to the sample below). 

 

6. Click OK to create the new 3D map window. 
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You will notice that in this example, no imagery is displayed. In this 
case, we are making use of the Default_Local.fly file as our base 
content file, and this content file does not contain any imagery, nor 
does it contain any terrain files. 

These types of data can be added using GeoMedia Desktop and 
GeoMedia 3D.  You will learn how to do this in subsequent tutorials. 

7. On the Home tab, in the Window group, click Arrange Windows > Tile Vertically to 
tile the two windows side-by-side. 

 

 

 

Now that you have two map windows, you can use named locations 
to co-locate items between the map windows; you can select items in 
one map window and these selections will appear in both windows. 

8. Use the navigation controls to explore the 3D map window. 

Task 3: Exit GeoMedia Desktop 

You have completed this exercise. You can now exit GeoMedia Desktop and run through the next 
exercise. Given that you may want to revisit this exercise, it is recommended you do not save any 
of your changes and can therefore restart the exercise with a clean GeoWorkspace. 

1. Click the Close icon in the upper-right corner of the GeoMedia Desktop application 
window to exit GeoMedia Desktop.  The system displays a warning dialog box. 

2. Click No. 

 

 

 





 

   

Understanding How Options Section 3:  
Can Affect Rendering 

Section Objective 

GeoMedia 3D has an Options command. This command allows you to configure selected items 
within the 3D environment.  Understanding how some of these options can impact the display 
aspects of the system is important. 

You must be connected to the Internet to complete this exercise, as one of the base content files 
used makes use of a TerraGate® connection to serve imagery and terrain information to the 3D 
map window. In this section, you will learn how to: 

 
 The Ignore Display by Scale for all legend entries option affects feature rendering. 

 The Enable light source option affects the colors used to color extruded areas and 3D 
models. 

 

Tools Used 

This collection of exercised makes use of the Option command and the Display by Scale 
command. 
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 Understanding the Ignore Exercise 1:
Display by Scale Option  

Objective: 
The objective of this exercise is to learn how to some of the display choices within the Options 
command can impact the display aspects and hence rendering performance of the system. 

Task 1: Launch GeoMedia Using a GeoWorkspace 

GeoMedia Desktop and hence GeoMedia 3D can be started just like any other Windows 
application. In this particular case, GeoMedia Desktop will be started using the GeoWorkspace 
that has been provided as part of this tutorial. 

1. Use your mouse and Windows desktop controls to navigate to C:\GeoMedia 3D 
Tutorial\GeoWorkspaces. 

2. Double click on Exercise 1c.gws. This action starts GeoMedia Desktop and opens 
the GeoWorkspace called Exercise 1c. 

 

This GeoWorkspace has five legend entries (Building_Footprints, Structure_Footprint, 
Wetlands, Parks, and Tax_Parcels) and in this case, Display by Scale has not been set for any 
of the five legend entries. 

Task 2: Understand Display By Scale 

The GeoMedia 3D Options command has a number of items that can be set. In this workflow, we 
are going to explore how the Ignore Display by Scale for all legend entries option can affect 
the display aspects of legend entries. 

1. On the 3D tab, in the Preferences group, click GeoMedia 3D to display the 3D 
Options dialog box. 

2. Click on the General tab to make it the active tab. 

3. Ensure the Ignore Display by Scale for all legend entries option is un-checked. 

When this option is unchecked, the automatic optimization process is ignored for legend entries 
that have Display by Scale settings. Specifically, the system honors (as closely as possible) the 
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Display by Scale settings and hence overrides the optimal 3D viewing distances that have been 
calculated for each legend entry. 

 

When the optimal 3D viewing distance calculation is overridden, the 
system rendering performance may be negatively impacted. 

For example, if you use a Display Scale Range such as 1:1 and 1:1,000,000,000 on a feature 
containing tax parcels, the system uses these values to calculate a 3D display range and the 3D 
display range controls when features are displayed. In this instance, the calculated 3D display 
range would be very large, and would thus cause the system to display the tax parcels even 
when viewing these features from a very large distance. 

4. If you have made a change, Click Apply to accept any option changes and then click 
Close to close the 3D Options dialog box. 

5. On the 3D tab, in the View group, click Toggle 3D to convert MapWindow1 into the 
3D map window. 

Your 2D map window will toggle to the 3D map window using a base content file. With this base 
content file, you should notice that imagery has been added to the map window. This imagery is 
being streamed via the Internet using a TerraGate server. 

 

Notice that only the imagery is displayed. Because none of the legend entries have a Display by 
Scale override, the system has calculated an optimal 3D viewing distance for each of the legend 
entries. 

In this particular case, the system has determined that the Building_Footprints, 
Structure_Footprint, Wetlands, Parks, and Tax_Parcels features should not be displayed at 
such a large viewing distance. 

6. On the Home tab, in the Extent group, click Zoom In to activate the Zoom In tool. 

7. Move your cursor to the center of the 3D map window and click once. 

 

The 3D view should zoom in; however, notice that no additional 
features are displayed. Remember, the system has calculated an 
optimal 3D viewing distance for each legend entry and in this case, 
the system has determined that the viewing distance is still too great 
to display the smaller features. 
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8. Move your cursor to the center of the 3D map window and click again. 

9. This time you should notice a difference, specifically, more features are now 
displayed. 

 

10. Move your cursor to the center of the 3D map window and click again. 

The automatic calculation for 3D viewing distance attempts to balance feature display with frame 
rate and thus the rendering performance. When the automatic calculation for 3D viewing distance 
is in effect for all legend entries, the rendering performance is consistent regardless of the 
number of legend entries/features. However, using the automatic calculation may hide some 
features more quickly than you would like. That is, you may see only features that are close to 
your viewing position. Given this, you can override the automatic calculation using the Display by 
Scale command within GeoMedia Desktop. 

11. On the Home tab, in the Extent group, click Fit All to fit all of the features in the 3D 
map window. Your 3D map window should look similar to the sample provided below. 

 

Task 3: Use Display By Scale to Control Feature Display 

As noted above, you can use the Display by Scale options to override the automatic calculation. 
Note that the more overrides you implement, the slower the system may render. However, if you 
minimize the number of overrides, you should be able to realize your viewing objectives. The goal 
is to strike a balance between the features that you want to view from afar with the features that 
you only want to view within a close proximity. For the purpose of this exercise, we will use the 
Display by Scale option to override the optimal 3D viewing distance for the two legend entries 
containing buildings and thereby allow buildings to be viewed from a much larger viewing 
distance. 
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1. Right click on the legend entry Structure_Footprint to highlight it and to display the 
right-click menu, then select Display Scale Range. 

2. Click the County  icon. (Notice that the Minimum value is set to 200,000 and that 
the Maximum value is set to 2,000,000). 

3. Enter 1 into the Minimum value drop-down list. 

4. Click OK to accept these changes and close the Scale Range dialog. 

Once you do this, the system will ask you if you want to change the display options to display by 
scale. 

5. Click Yes to enable this option. 

You may start to see these features populate within the 3D map window. Specifically, the 
buildings within the downtown area of Honolulu will begin to display. These buildings are 
relatively small at the current viewing distance and therefore it may be difficult to see these 
buildings. 

6. Before zooming in, apply the same settings to the Building_Footprints legend entry. 

Once you have applied the same setting for the Building_Footprints legend entry, you may start 
to see these features also populate within the 3D map window. Again, these buildings are 
relatively small at the current viewing distance and therefore it may be difficult to see these 
buildings populate within the window. 

7. Zoom in a little and observe the differences. 

Please note that if Display by Scale is not applied to a legend entry, the system will always 
automatically calculate an optimal 3D viewing distance. Given this, the following best practice is 
suggested. 

Ensure that the Ignore Display by Scale for all legend entries option is unchecked and that 
Display by Scale is not being applied to any legend entry, toggle to 3D, and examine the 
rendering results. If you feel that some features are not rendering far enough away from your 
view position, use the Display Scale Range option in GeoMedia Desktop to override the optimal 
value and hence display objects that are farther away from the viewing point. 

8. Experiment with different display scale ranges until you are satisfied with the results. 

9. Use the navigation tools to set a 3D view that is similar to the one noted in the 
example below. 

 

In the example above, you should notice a clear demarcation line (that is, a line in the distance 
where Tax_Parcels features are no longer being rendered). In this case, since a Display by 
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Scale setting has not been applied to this legend entry, the optimal 3D viewing distance 
calculation is being used. 

Just as we did above, you could apply an override to extend this demarcation line. 

 

In the example above, a Display by Scale setting of 1:200,000 was used. Notice that the 
Tax_Parcels features now extend far off into the distance. With this setting, you may now notice 
a drop in frame rate and hence some pauses during the navigation. 

The important concept to understand is that Display Scale does not work the same when you are 
in a 3D window, even when you are viewing from directly about the surface. Unlike a 2D map 
window where the display scale is constant no matter where you are within the window, the 
display scale varies throughout the view while in a 3D Window. 

 

In the example above, the scale at location A is approximately 1:1200, while the scale at location 
B is approximately 1:120,000. Given this variability, the system uses the Display Scale to 
estimate when items should be toggle on or off. 

The same approach is used when Display by Scale is applied to imagery and surface data. 
Typically you should not need to apply Display by Scale settings to imagery when in a 3D 
window, but should you want to, understanding how Display by Scale settings affects the display 
can be useful in helping understand what values to use for your data. 

In the example below, no Display by Scale setting are used. In this case, the system displays 
the entire image even when at a distant viewing position. 



44 Understanding How Options Can Affect Rendering 

 
 

 

This image will not turn off as you zoom out nor will it turn off as you zoom in. However, should 
you want to free up some rendering resources, you could make use of Display by Scale. For 
example, use a Display by Scale setting of 1:500,000. 

When you do this, the areas that fall outside the calculated viewing distance are feathered (in the 
example below, the edges of the image are feathered). 

 

If you zoom out from the viewing location, you will notice that more and more of the image is 
feathered until the image disappears. 

     

Please note the same effect of feathering is applied to surfaces (that is, as surfaces are 
feathered, less resolution is used to represent the underlying surfaces and therefore the elevation 
in these areas will look smoother in these areas). 
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 Using the Sun and Date/Time Exercise 2:
Commands  

Objective: 
The objective of this exercise is to explore how the Sun and Date/Time commands can affect the 
display aspects of extruded area feature classes and 3D Models. 

Task 1: Navigate 

With GeoMedia 3D you can control the level of ambient light for your environment using the Sun 
command in together with the Date/Time command. Please note that both the Sun and 
Date/Time commands can also be used in tandem with the Shadows command to cast shadow 
however, shadow casting is covered in another tutorial. 

1. Use the navigation tools to locate an area within the dataset that has both simple 
extrusions and some simple 3D models. 

 

2. Make note of the textures and colors used to represent these models. 

Task 2: Set the Fixed Local Time Option 

GeoMedia 3D preferences are accessible via the 3D Options dialog box. This dialog box is 
divided into a collection of tabs; each one containing a different set of controls. These controls 
can be used to modify your GeoMedia 3D preferences. All settings are user preferences, that is, 
the values you set will be persisted from session-to-session on a per-user basis 

The 3D Options dialog box contains an Effects tab. In this case you are going to use the Use 
fixed local time option to ensure the time setting is the same regardless of where you are in the 
world. That is, the system places the light source in a location that reflects where the sun would 
be if you were at the specific location on the earth. 

1. On the 3D Effects tab, in the Preferences group, click GeoMedia 3D to display the 
3D Options dialog. 

2. Click on the Effects tab to bring this tab to the forefront. 

3. Ensure that Use fixed local time is checked. 



46 Understanding How Options Can Affect Rendering 

 
 

4. Ensure Current time is set to 11:00 AM. 

5. Click the Apply button to persist this change. 

6. Click the Close button to close the 3D Options dialog. 

Task 3: Toggle Sun On 

The Sun command is used to toggle a sunlight source on or off. When this option is toggled on, 
the sun and moon are displayed and positioned in the sky based on the time of day and optionally 
the date and time zone. 

By default the sun is toggled off. When this option is off, only ambient light is use to illuminate the 
3D environment. When only ambient light is used, 3D models can appear a little flat (that is, 
edges within 3D models are subtle). In the example below, the tank on the left is being rendered 
with the Sun toggled on and the time is set to 11:00 AM. 

 

As can be seen, there are a number of edges in the model and these edges are easily 
discernible. While the tank on the right is being rendered with the Sun toggled off (ambient light 
only). Notice that the edges are no longer visible and the tank looks almost two-dimensional. 

If you examine the next example below, you should notice that the traffic signal on the left 
appears to contain a higher level of detail; however, like above, the picture on the left was taken 
with the Sun toggled on. 

  

It is important to understand that you may not always want the light source enabled as the light 
source can slightly alter colors that make up and object. In the example below, the hotspot 
representations on the left are being rendered with the Sun toggled on and the time is set to 
11:00 AM. Notice that the colors do not perfectly match those in the legend as the light source 
brighten the colors within the 3D environment. 
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While the hotspot representations on the right are being rendered with the Sun toggled off 
(ambient light only). Notice that the colors match those in the legend. 

 

Given this, you will want to experiment with this setting to ensure that you get the results that you 
need for your specific application. 

1. On the 3D Effects tab, in the Illumination group, click Sun to toggle the sun on. 

 

You should notice that the colors associated with both the 
Building_Footprints and Structure_Footprint features have 
lightened up a little. 

 

The change in color reflects that a light source has been added and that this light source is 
placed in the sky at 11:00 AM. 

 

 

As noted above the 11:00 AM setting is the same regardless of where you are in the world. 

Task 4: Use the Date/Time Slider 

The Date/Time command is used specify a time of day and optionally a date for the position of 
the sun in the sky. When this command is specified, a slider is displayed in the 3D map window. 
This slider can be used to dynamically select a time of day. 

1. On the 3D Effects tab, in the Illumination group, click Date/Time to toggle the 
Date/Time slider on.  
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The Date/Time slider will appear in the upper left corner of the 3D 
map window. This slider, like all sliders within GeoMedia 3D are 
semi-translucent when not in use. 

2. Position your cursor over the Date/Time slider. 

 

The slider will turn opaque and additional elements will display. 
Notice that the time is set to 11:00 AM. 

3. Use the slider to set the time to approximately 6:00 AM. 

 

Notice that as you move the slider, the 3D environment progressively 
darkens as the sun gets repositioned in the sky. Note: If you want to 
key-in an exact time, this can be done in the 3D Options dialog. 

4. Use the slider to set the time to approximately 6:00 PM. 

 

Notice that as you move the slider to the right, the 3D environment 
progressively lightens then progressively darkens as the sun gets 
repositioned in the sky. 

Task 5: Reset 3D Preferences 

In preparation for the next exercise, we want to reset all of the 3D options back to their default 
settings and we want to toggle all of the Illumination tools back to their original state. 

1. On the 3D Effects tab, in the Preferences group, click GeoMedia 3D to display the 
3D Options dialog. 

2. Click the Default settings button to reset all of the preferences back to their factory 
settings. 

3. Click the Apply button to persist this change. 

4. Click the Close button to close the 3D Options dialog. 

5. On the 3D Effects tab, in the Illumination group, click Date/Time to toggle the 
Date/Time slider off. 

6. On the 3D Effects tab, in the Illumination group, click Sun to toggle the sun light 
source off. 

At this point, the system preference settings should now reflect the state when you started this 
exercise. For additional information regarding the Illumination commands and options, please 
refer to the on-line help or run through the Working with Effects tutorial. 
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Task 6: Exit GeoMedia Desktop 

You have completed this exercise. You can now exit GeoMedia Desktop and begin the next 
exercise. Given that you may want to revisit this exercise, it is recommended you do not save any 
of your changes.  By not saving your changes, you can restart the exercise in the future with a 
clean GeoWorkspace. 

1. Click the Close icon in the upper-right corner of the GeoMedia Desktop application 
window to exit GeoMedia Desktop.  The system displays a warning dialog box. 

2. Click No. 

 

 

 

 

 

 


